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Lesson Objectives
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Lesson 1: Introducing Excel

e

In this lesson you will be introduced to the Excel program, learn how it works, and understand how to move in
the program, create a workbook, enter data into a worksheet, and work with files. Upon completion of this

pl

lesson, you should be able to:

understand what an electronic spreadsheet is



move around a worksheet



understand what Excel is and what it can do



use the Backstage view to save, create new,



identify elements on the Excel screen



understand some basic terminology



switch between workbooks



use the Quick Access Toolbar



save in a previous version Excel format, and



move around in Excel



use keyboard shortcuts



enter text, numbers, dates, and times
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open, and close a workbook

check for compatibility issues


manage files and folders



select cells
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Lesson 1

Introducing Excel

What is Excel?

Excel is an electronic spreadsheet program developed by Microsoft, originally for the Windows environment,
but is now available for the Apple Mac or any computer with a web browser. A powerful tool for analyzing
and presenting information, Excel actually consists of three programs in one:

Spreadsheet – Entering and analyzing numeric data in applications such as financial forecasting and

statistical problems. Excel performs math calculations so quickly that they appear to be simultaneous. Excel
uses the term worksheet in place of spreadsheet.

Graphics – Creating charts to represent numeric data.

y

Database – Compiling and sorting lists of data.
Some of Excel’s advantages are:

It is relatively easy to learn. All Microsoft Office Suite programs, such as Word, Excel, and PowerPoint,

nl

•

operate similarly. Many of the skills you learn in one program carry over to others.

•

It enables data to be exchanged easily between the different Office programs. For example, you can
create a chart in Excel and insert it into a document you are writing using Word.

Excel can produce output of print-shop quality using features such as the spelling checker and other

O

•

tools that enhance your work and provide it with a professional look.

•

Excel has a large selection of mathematical, financial, statistical, and database functions. It includes 14
basic chart types and each of the commonly-used chart types have four or more subtypes. There are also
some tools for forecasting or analysis, and a function helper.

Worksheets can be grouped together in a single file rather than separate files. In Excel, these files are

e

•

called workbooks. Inside a workbook, there are several ways to manage the multiple worksheets such as
•

pl

renaming worksheet tabs.

Excel uses AutoFill to fill selected cells with data that follows from the information in the first of the
selected cells. For example, if you select four cells, and the first cell contains Qtr 1, AutoFill will fill in the
next three cells with Qtr 2, Qtr 3, and Qtr 4.

•

By default, edits occur directly in the cell. This includes formatting portions of text and making font
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changes. Alternatively, you can perform edits in the Formula bar.

Although Excel is a very large program, it is enjoyable to learn and use. Most people find it takes them less
time to become competent and productive with Excel than they initially anticipated. For the purpose of this
courseware, we will assume that you are using Excel on a Windows computer.

Starting Excel

In Windows 10, there are several ways to start the Excel program:

•

if it is present in the Start window, click or tap the Windows
Start button, then select the Excel 2016 tile from the Start

window.
•

click the Windows Start button, then select All apps, and
then Excel 2016.

•

2

in the taskbar, click or tap the Excel 2016 Quick Launch icon.
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Looking at the Screen

When Excel starts, a new workbook opens and the screen displays as follows:
Quick Access
Toolbar

Ribbon

Title
Bar

Close
Maximize/Restore
Minimize

Name Box

Insert Function

Formula Bar

Tell Me

Scroll
Bars
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Row Headings

O

Column
Headings

Active Cell
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File
Tab

Sheet Tab

Status Bar

View Buttons

Zoom Slider
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File Tab – Click this tab to open the Backstage view from which you can select commands to manage files,
such as create, save, open, print, export or change Excel options. A panel at the left displays commands that
may include tabs with a set of sub-commands to manage the file.
Quick Access Toolbar – Located above the Ribbon, this provides quick access to frequently used commands.
You can customize the toolbar to contain commands you use regularly.

Title Bar – Located at the top of the screen, the title bar indicates the contents of the window (for example,
Book1, Department Budget). It may also show the text [Compatibility Mode] if the workbook you are using
has been saved to be compatible with a previous version of Excel. If more than one window is open on the
screen, the one with a title bar that has a darker color or intensity is the active window.
Minimize, Maximize, Restore Down, Close – Located in the upper right-hand corner of the window, these
buttons enable you to minimize ( ) the application window to a button on the taskbar, maximize ( ) the
program to full screen, restore ( ) the window to its original size, or close ( ) the application window.
Ribbon – A collection of tabs (for example, File, Home, Insert, Page Layout) provides quick access to
commands you need to complete a task. Each Ribbon tab relates to a type of activity such as inserting objects
in a worksheet, or modifying the format of data in a worksheet. In the example above, the Home tab is
currently selected, and all of the icons and options for that Ribbon tab are displayed.
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Ribbon Group – Each Ribbon tab contains groups of related commands to edit, format, or enhance items in
your documents. Some groups have a Dialog box launcher button at the bottom right, which displays a
dialog box or window with more commands and options.

Ribbon Display Options – Controls whether to hide or display the Ribbon with the tabs or with both tabs
and command buttons.

Name Box – Located on the left below the Ribbon, this displays the cell address of the active cell. For
example, if the Name Box displays A21, this indicates that A21 (the cell at the intersection of column A and
row 21) is the active cell. In the example on the previous page, three cells are selected. Cell B6 is the upper
left-most cell of that cell range and therefore its cell address is displayed in the Name Box to designate it as
the active cell.

y

Insert Function – This tool opens a dialog box to help you choose and insert a built-in function.
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Formula Bar – Located to the right of the Name Box, the Formula bar displays the contents of the active cell.
Under certain circumstances, the Formula bar can be used to make entries into the worksheet.

Tell Me – This allows you to enter a description of what you are looking for. Unlike the simpler help feature
in older versions of Excel, the Tell Me feature will display a customized menu of the commands that you are
looking for. You can also choose the Smart Lookup option which will use the Microsoft Bing search pane to
find related topics from the Internet in a task pane. The traditional help feature is also offered in the menu.

O

Column Headings – Sequential letters at the top of each column enable you to track columns.

Row Headings – Sequential numbers on the left side of each row enable you to track rows.

Status Bar – Displays the current cell mode, auto calculations, the View buttons, and the Zoom slider. You
can customize the Status bar to display keyboard locks and other features.

e

View Buttons – These buttons change the on-screen views for the worksheet. The views are Normal, Print
Layout, and Page Break Preview.
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Zoom Slider – The buttons at either side of the slider allow you to increase or decrease the zoom by 10%,
or you can drag the slider button to choose a particular zoom percentage. Excel displays the current zoom
percentage in the Zoom level button, at the right of the View buttons. You can also click this button to set a
custom or specific zoom percentage.

Sa
m

The previous screen shot displays various commonly used areas of the Excel screen. Because you can
customize the screen’s appearance, not all parts always appear. For instance, some people prefer to have the
workbook displayed as a window on the screen, while others prefer to maximize the workbook. It is also
possible to change the overall color scheme for the Excel window, as well as individual components within
each worksheet.
ScreenTips help identify buttons or elements on the tabs of the Ribbon and
the screen. To view a ScreenTip, position the mouse cursor on the item. A tip
then displays the name of the button along with a description of the purpose
of this item. For some items, a keyboard shortcut may also display as an
alternative for activating this feature.

Many Ribbon Groups also have a dialog box

launcher button. By hovering the mouse cursor
over it, the Screen Tip will display a summary of its
purpose, as demonstrated in this example:

4
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A number of the elements shown in this section can be set to show or hide, as you prefer. In most cases, you
can change your display options by clicking the File tab, clicking Options, and then clicking the General or

Advanced categories.

Understanding Basic Terminology
A worksheet is similar to an extremely large sheet of paper divided into rows and columns. In Excel, the rows
are numbered from 1 to 1,048,576. Each of the 16,384 columns is named with a letter combination starting
with A to Z, then AA to ZZ, then AAA to AZZ, up to column XFD.

Workbook – A single Excel file containing one or more worksheets (for example, Sheet1, Sheet2, Sheet3) is

y

called a workbook. You can have more than one workbook open at any time but you can only work in one
of them at any one time. The workbook that is currently open and on top of all other workbooks or other
Windows programs is called the active workbook.

nl

Worksheet – A worksheet is a two-dimensional arrangement of cells in rows and columns. When you use a

workbook with multiple worksheets, you can only use one worksheet at any one time. The worksheet that is
currently displayed is called the active worksheet.

Cell – Located at the intersection of every row and column, a cell holds a single value, label, or formula. It

O

may also contain comments, formatting, and other related data. The cell where you are entering data or the
current location of the cursor is called the active cell.

Cell Address – Excel has more than 17 billion (x 109) cells available per worksheet (1,048,576 rows x 16,384

e

columns). Each cell has its own distinct address (its point of column-by-row intersection) such as B6 (column

B at row 6).

Sizing – When the Excel window is not maximized, you can change its overall size and aspect ratio. By

positioning the mouse over any of the four edges of the window, the mouse pointer will change to a doubleor

). You can then click and drag the edge to change the width or height of the window.

pl

headed arrow (

If you position the mouse over any of the four corners of the window, you will see a diagonal double-headed

arrow (e.g.

), which will allow you to drag both adjacent edges at the same time.
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Mouse Symbols

This section introduces some of the common mouse symbols and their purposes:
Select a cell or range of cells in the worksheet.

Move or copy selected cells by dragging and dropping.
Select items, command buttons, and menu options.
Size objects.

Edit text within the Formula bar or a cell.
Indicates the use of the AutoFill feature to copy the contents of cells.
Provides a guide for the top left and bottom right corners when creating objects.
Change the column width or row height.
Move the split bar between the window panes.
Select an entire row or entire column.

It is possible to use Excel with a touchscreen, however, you will find it is generally easier to use a mouse and
keyboard.
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Using the Quick Access Toolbar
The Quick Access Toolbar (also known as QAT) is located at the left of the title bar above the Ribbon and

contains buttons for frequently used commands. By default, this toolbar contains the Save, Undo, Redo, and
Customize Quick Access Toolbar buttons.

Save

Redo

Customize Quick
Access Toolbar

y

Undo

Using the Ribbon

nl

The Ribbon can help you quickly find commands you require to complete a task. Commands are grouped in

tabs with each tab relating to a type of activity such as inserting items, changing the view, and formatting
text in the document. You can customize the Ribbon to display commands you use frequently in a particular

O

order, or to add or remove commands for a Ribbon tab.

Sa
m

pl

Design, Add Chart Element).
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To reduce screen clutter, contextual tabs appear only when they are applicable (for example, Chart Tools,

The active button is the one that appears in a different color or has an outline around it. Many of these
deactivate when you click the same button or click another choice. For example, the Bold command can be

applied to selected text by clicking that button. To turn off the boldface, click the same button again. If you

want text to be larger, click the down arrow for the Size button and choose the required size. When you need

to change the font size again, click the down arrow for Size and then select the new size.

When the Ribbon displays different choices (as shown in the Chart Styles list in the screen above), one item

has a border around it to indicate it is active. To see how the text would appear with another style, point the
mouse on one of the other items. Excel previews the effect that will take place if it is selected.

Each tab on the Ribbon contains groups with similar commands. For example, the Home tab has a group

called Font that contains buttons for formatting text characters, and the Insert tab contains a group with
different types of graphics or illustrations that can be inserted into a worksheet.

If a group shows a feature with a vertical scroll bar, it also has a button below the
bottom scroll button, a triangle with a bar above it, which you can click to display
the full list or gallery for that option.

6

3263-2 v1.00 © CCI Learning Solutions Inc.

Lesson 1

Introducing Excel

This is the More button and, when clicked, it displays a gallery with more options, as seen below. As you

point the mouse cursor at an option, Excel displays a Live Preview for how the selected item will appear if

Click the

O
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you apply this feature. You can turn off this feature in Excel Options.

dialog box launcher button at the lower right of a group to show the corresponding dialog box

e

with more options for this feature. In some cases, a task pane may appear at the left or right side of the
screen instead of a dialog box. The dialog box launcher button displays the name of the dialog box or task
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pane window that will appear when clicked.

Dialog Box

Task Pane

Within the dialog box, you can select items from the lists, use the arrow for a list box to display more choices
for that list, or click a command to turn the feature on or off. It may display a preview of the changes.
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A dialog box displays the various options that you can select to perform a change to a worksheet or cells

within a worksheet. Once you click OK to perform the change, the dialog box closes. A task pane is similar to
a dialog box because it is used to make changes to parts of the worksheet, except that it remains open until
you close it. An example of a task pane is the Office Clipboard which collects and displays the items selected
when the Cut or Copy command is used.

If you want to show more lines on the screen or you do not want to display the Ribbon, you can minimize it.
To minimize the Ribbon, use one of the following methods:
point at the

button at the upper right of the screen, then click Show Tabs, or

•

right-click anywhere on the Ribbon and then click Collapse the Ribbon, or

•

double-click on any Ribbon tab, or

•

press CTRL+F1.

y

•

nl

Using the Keyboard

You can also access commands in Excel using the keyboard. Some users consider the keyboard to be a faster

method for accessing commands. There is also the benefit of consistency between Windows programs, in
CTRL+S to save, or CTRL+P to print.

O

that many keyboard shortcuts are the same in all Windows programs such as pressing CTRL+C to copy,

To access the Ribbon using the keyboard, press ALT or F10 to display the keyboard buttons for the commands

pl

e

in the Ribbon.

When you press the key for the appropriate feature, Excel displays the next set of keys you can use to select
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a command or feature. For example, pressing P displays the Page Layout tab.

If the Ribbon command displays more options, then you can select from those available key options as well.

Learn to use the Ribbon

This exercise demonstrates how to use various features on the Ribbon.
1

Start Microsoft Excel.
The Excel Startup screen is displayed. From here, you can choose to open an existing workbook or create
a new one using a workbook template.

8
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Click Blank workbook to create a new blank workbook.

3

Click the File tab to display the Backstage view.

4

Click the

5

Use the mouse pointer to point to the View tab.

O

2

(Back) button to return to the workbook.

e

Notice how the View tab changes color even though you have not clicked it.
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Entering Data in a Worksheet

If you design and build it in a logical manner, an Excel worksheet is a very powerful tool. The basic building
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block of every worksheet is entering data into the cells.

Types of Data

You can make three main types of entries when you insert data into worksheet cells:
Numeric – Numeric data form the core of all worksheets. This type of data consists of number, date, or time
values that you enter directly into a worksheet cell. By default, numeric values align to the right in a cell.

Text – Text data consist of alphabetic and numeric characters and most printable symbols. Text data are
usually labels or titles used to describe and explain the data in adjoining cells. Text is seldom included in

calculations, but Excel does include several functions that apply to text data. If you enter a text value that is
wider than the cell, it will flow into the adjacent cells as long as those cells are empty. By default, text data
align to the left in a cell.

Formulas – Formulas, which you enter in individual cells, are composed of values, cell references, arithmetic

operators, and special functions for calculating and displaying result. These results may then become part of

other formulas located in other cells. The ability to use formulas is what differentiates spreadsheets from
word processing software like Microsoft Word.
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Entering Text
To enter data, move your pointer to the desired cell, click in it, and type the entry. If you make a typing error
while still entering information in a cell, press the BACKSPACE key to erase your mistake. When you have
finished entering data in a cell, press the ENTER key to move the cell pointer automatically to the next cell

down. Alternatively, use your mouse to click another cell (or press any arrow key), which performs the same
result of storing the data in that cell and moving the cell pointer to the new location.

The best way to begin any worksheet is to enter column and row titles that identify the purpose of the
numeric data. When you enter titles for the worksheet, you are creating an outline of the relationships you

y

will later represent mathematically.

Learn to enter text data

nl

When typing information, notice that Excel displays the text in two places:

This exercise demonstrates how to enter text data into a worksheet cell, which will serve as a label or title for
1

In the blank workbook, click in cell A2.

2

Type: Price Quote and press ENTER.

O

other cells containing numeric data.

Notice the current active cell is now A3. When you press ENTER, Excel completes the entry of data in the

e

current cell, then moves the cell pointer to the next cell down.
Press ENTER twice to move down two rows.

4

In cell A5, type: Airfare and press ENTER.

pl
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Entering Numbers

Numbers, such as those representing dollar and percentage values, are constant – that is, they do not change.
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They are typically used as part of calculations, with results appearing in other parts of the workbook.

By default, Excel aligns numeric values to the right side of a cell. They are displayed with no commas unless

you enter them at the same time. Extraneous zeroes at the far left or right are not displayed, even if entered
at the same time. You can format the values to your preference at a later time.

If you enter a value that contains a mixture of alphabetic and numeric digits (for example, T-1000), Excel

treats the entire entry as text and aligns it to the left of the cell.

Learn to enter numeric data

This exercise demonstrates how to enter numeric data into a worksheet cell.
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1

In cell B5 of the workbook, type: 450 and press ENTER.

2

In cell B6, type: 1,050 and press ENTER.

3

In cell B7, type: 225 and press ENTER.

4

In cell B8, type: 46.50 and press ENTER.
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Entering Dates and Times
Excel is also capable of handling date and time values. When entering dates, note the following:
•

If you enter a full date value including the month, day, and year value, the date value will display as
dd-mmm-yy by default.

•

The date value does not have to be the full day, month, and year. It can be just the day and month
(format is dd-mmm), or the month and year only (format is mmm-yy).

1

In cell A3, type: As of: and press TAB.

2

In cell B3 type: 30 Jun and press ENTER.

nl

This exercise demonstrates the use of dates.

y

Learn to work with dates

O

Notice that Excel puts the date in the default format and aligns it to the right.
3

In cell D3 type: Expires: and press TAB.

4

In cell E3 type: Jul 15, 2016 and press ENTER.

e

Working with Workbooks

As you begin using workbooks, you need to consider how to organize your files for quick and easy access.

pl

This includes considerations such as how you name the file, where you save it, whether it needs to be saved

as a specific file type, and whether you want to add or change the file properties to make it easier to find at
a later date. The Save commands are located in the Backstage view via the File tab.

Sa
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Saving Workbooks

To be able to recall your work later, you must save your workbook before exiting Excel or turning off your

computer. The saved file also provides an excellent fall-back option if you try something in your worksheet
that does not work as you expected, and you are unable or unwilling to undertake all the necessary steps to
correct the problem.

When naming a workbook, keep the following in mind:
•

Workbook names must follow the same basic rules as naming files in Windows: a maximum of 255
characters (including the drive and folder path), and none of these characters: / \ : * ? “ < >|

•

File names should be descriptive so that you can identify the contents quickly.

•

Excel automatically assigns a .xlsx extension or file type at the end of the file name, so you need not do
this. You only have to type in the name for the workbook.
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In this exercise, you will save the new workbook you have just created.
1

In the Quick Access Toolbar, click Save.

The Backstage view is displayed, and the Save As command is selected. Even though you clicked Save,

e

Excel will automatically skip to Save As for any new workbook that was never previously saved. The Save

command will save the current workbook to disk using the same workbook name and storage location.

pl

The Save As command is needed to ask you to assign the workbook name and storage location.

Selecting Cells

The ability to select a range of cells is a fundamental skill in Excel. Prior to issuing a command or undertaking
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a procedure, you must indicate what part of the worksheet you wish to affect with the command. Range
selection is the means to indicate this area.

A range selection can be as small as a single cell, or as large as the entire spreadsheet. Excel keeps the cell(s)
highlighted until you change or remove the selection. Clicking a cell or using an arrow key will remove the
selection.

In a worksheet, you can select:
•

a single cell, that is, the active cell

•

a single range, for example, a rectangular section of a worksheet containing two or more cells

•

multiple ranges of cells

Excel displays the selected range by reversing the color of the cells. Within the selected range, one cell

appears in a normal color. This is the active cell of the range.

12
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Learn to select cell ranges

This exercise demonstrates how to select ranges of cells using the mouse in a blank worksheet so you can
quickly identify the ranges.
1

Create a new blank workbook if necessary.

2

Select a single cell by clicking cell A9.

3

Select a range of cells by holding the left mouse button down in cell A9, drag the mouse to cell C5, and

then release the mouse button.

Select an entire column by clicking on the column E header at the top of the worksheet.

5

Select an entire row by clicking on the row 14 header on the left side of the worksheet.

6

Select the entire worksheet by clicking Select All in the top left corner of the worksheet (the gray triangle
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to the left of the column A header and above the row 1 header).

Now that you have completed this lesson, you should be able to:
understand what an electronic spreadsheet is



move around a worksheet



understand what Excel is and what it can do



use the Backstage view to save, create new,



identify elements on the Excel screen



understand some basic terminology





use the Quick Access Toolbar





move around in Excel



use keyboard shortcuts



manage files and folders



enter text, numbers, dates and times



select cells

e



switch between workbooks
save in a previous version Excel format, and
check for compatibility issues
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open, and close a workbook

Review Questions
1.

You should use an electronic spreadsheet if you want to:

a.

Create a presentation for viewing at a kiosk.

b.

Perform a large number of mathematical calculations and display charts and graphs.

c.

Track extremely complex data relationships.

d.

Create and print a full-color brochure for investment brokers.
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What is the difference between a workbook and a worksheet?
a.

A worksheet is a document created in Access, while a workbook is created in Excel.

b.

A worksheet can contain numbers, text and formulas, whereas a workbook can contain only

c.

A worksheet is a document divided into columns and rows, whereas a workbook is a single Excel file

d.

A worksheet contains data for viewing onscreen only, whereas a workbook can be printed.

numbers.

containing one or more worksheets.
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2.

Introducing Excel
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